Remote Data Entry Introduction

Minimum System Requirements

Installation Instructions for Remote Registration and Data Entry Application
  Hints and Recommendations
  Java Installation Instructions
  System Requirements
  Automatic Installation of Current Release
  Manual Installation of the Current Release
  Installing the Remote Data Entry System Application
  Create a Desktop Shortcut to Remote Data Entry Application

Start Using the Remote Data Entry Application
  Launch the Application
  Login to the Application and Select Study & Subject
  Enter a New Form
    Navigation within the Application Window
    Open a New Form
    Navigation and Data Entry within the Form
      Movement from Data Field to Data Field
      Field Types
      How to Use the “Comment” Option
      How to Use the “Not Done” Option
      How to Use the “Validated” Option
      How to Use the “Not Clear” Option
      MedDRA Code Dictionary Lookup
    Save & Close Form
      How to Close Form
      How to Save As: Complete
      How to Use the Work in Progress Feature
    View or Edit an Existing Form
    Print Form

Understanding the Menu Operations
  Menu Items within the Application Window
    File Menu
    Options Menu
    View Menu
    Refresh Menu
    Help Menu
  Menu Items within the Forms Window
    File Menu
    Options Menu
    View Menu
    Help Menu
Remote Data Entry Introduction

The original cancer center database was created in 1976; using the IBM mainframe. In June of 1996 the Ingres database was implemented and the database was made available for Mayo Clinic staff data entry.

In approximately the year 2000, the remote application was made available for all remote staff; for event monitoring only.

In November 2004, it was announced that all treatment trials activated after 2003, would be made available via remote data entry; totaling 35 studies.

In September 2006, it was announced that all new Cancer Control Studies and Quality of Life were made available for remote data entry.
Minimum System Requirements

- **Hardware Requirements**
  - CPU/Processor Speed: 400 MHz
  - You will also need a minimum of 150MB of disk space
  - RAM – Minimum: 64 MB
    Preferred: 256 MB (or higher)
  - Monitor Size: 17 inch (or larger)
  - Resolution Setting: 1024 x 768 pixels w/a minimum of 16 thousand Colors; millions of colors would be preferred

- **Supported Operating Systems**
  - Windows 98 (2\textsuperscript{nd} Edition)
  - Windows ME
  - Windows 2000 (SP3+)
  - Windows XP Home
  - Windows XP Professional (SP2+)
  - Windows Server 2003 Edition
  - Mac OS 10

- **Supported Browser’s**
  - Internet Explorer – Version: 7.0 (or higher)
    Cipher Strength (Encryption Level): 128 bit (or higher)
  - Netscape Navigator – Version: 6.0 (or higher)
    Encryption Strength: 128 bit (or higher)
  - Mozilla Firefox – Version: 1.02 (or higher)
Installation Instructions for Remote Registration and Data Entry Application

This section will walk you through the process of installing the required Java application (auto install and manual install) and the Remote Data Entry application.

Hints and Recommendations

- If you already have Java runtime version 1.5.0_02 or newer installed on your system, you do not need to perform the installation instructions for Java and can go directly to the "Start Using the Remote Data Entry Application" section of this document. If you have a previous version of Java installed on your system, we recommend you use these instructions to install the latest version of Java runtime. Your system administrator can help you determine what version of Java you have installed on your system.

- It should be noted that the images included all refer to Java 1.6.0_11. As this may be a previous version of the Java Runtime Environment it could include some enhancements from Sun, the creator of Java. While the current version may have changed, all other aspects of the installation should remain the same.

- Our instructions are created using the Internet Explorer browser. You may use the Firefox browser, however, you may not see the same screens that are described within this document or some of the screens may be slightly different. We have identified the screens that may be different in the sections below.

- If you install a newer version of Internet Explorer or Firefox after you have successfully completed the installation of Java, you must re-install Java. You may use these same instructions to re-install.

- We recommend that you use the same browser for the installation and for the remote applications. For example, if you use Internet Explorer to install Java, we suggest you use Internet Explorer to run the applications.

- Within the instructions you will find red circles on the screenshots indicating the buttons that you will need to click.

You must install Java 1.4.2 or later in order to run the new versions of the Data Entry and Registration systems. We recommend that you install the latest Java release on your computer prior to installing the application. The following instructions will assist you with installing the latest version of Java on your computer. Before starting the installation, we recommend that you print the instructions to guide you through the Java installation.
Java Installation Instructions

There are two options when proceeding with the installation of Java on your system. The automatic installation will access your system to determine your system platform, download the appropriate Java software, and install it. If you feel more comfortable with stepping through the process manually, advance to the section on manual installation. Depending on your network and computer system environment, your system may require local system administrative privileges to complete the Java installation.

System Requirements

- Vista
- Windows 2000 (SP3+)
- Windows XP Home
- Windows XP Professional (SP1+)
- Windows Server 2003 Editions

Intel and 100% compatible processors are supported. A Pentium 166MHz or faster processor with at least 64MB of physical RAM is recommended. You will also need a minimum of 98MB of free disk space.

Automatic Installation of Current Release

The automatic Java installation will automatically install the application with minimal interaction needed from you.

- Click here to access the Sun Java Software download web page.
- If you do not have the most recent version of Java installed on your system, the version will be displayed to the left of the “Free Java Download” button.

Figure 1

Click on the “Free Java Download” button to start the Java installation. If you do not have the most recent version of Java installed on your system, you will see the version available displayed here.

- Click on the “Free Java Download” button.
• The “Downloading Java Installer” will initialize and a separate pop-up window will appear.

**Figure 2**

![Java Installer downloading](image)

• The installation process starts and the “Java Setup – Welcome” window will appear. The installer presents an option to view the License Agreement. After reading the agreement, click the “Accept” button to accept its terms and to continue with the installation. If you'd like to change the installation directory, or customize other features, place a check in the “Change destination folder”.

**Figure 3**

![Java Setup - Welcome](image)

Click on the “Accept” button to accept the Java License Agreement and continue the Java installation.

• The “Java Setup - MSN Toolbar” window is displayed. By default the “Install the new MSN Toolbar” box is checked. If you do not want this installed, you will need to remove the check mark by clicking the box to remove the check mark. Then click on the “Next” button to continue the Java installation.
If you choose not to have the MSN Toolbar installed, click in the box to remove the check mark.

Then click the “Next” box to continue the Java installation.

The “Java Setup - Progress” window will appear and Java will be installed.

After the Java installation is completed you will see the “Java Setup – Complete” window that indicates that you have successfully installed Java. Click the “Finish” button to complete and close the Java installation window.
Once the installation is successfully completed, you may need to restart (close and re-open) your browser to enable the Java installation.

**Manual Installation of the Current Release**

The manual installation is designed for experienced system administrative users and will require you to walk-thru the Java installation step-by-step.

- Click [here](#) to access the Sun Java SE download page.
- Click on “Downloads” – your system is accessed and if you do not have the latest version of Java installed on your system, it will automatically start the installation.
- If your Java download does not start automatically in a few seconds, click where it says, “click here to start the download” and follow the screen instructions as indicated in the “Automatic Installation of Current Release” section of this manual.
• To manually select the appropriate system platform and environment for your system, click where it says, “See all Java downloads here”. Please note that if your system environment requires an earlier version of Java, this will not be an issue as long as the release is not older than the 1.5.0_02 release.

• Click on the appropriate system platform for your system.

The “File Download – Security” window will appear. Click on the “Save” button.
• The “Save As” window will appear. Save the file to your desktop.

• The “Download complete” window will appear. Click on the “Run” button to initiate the Java installation.
• The installation process starts and the “Java Setup – Welcome” window will appear. The installer presents an option to view the License Agreement. After reading the agreement, click the “Accept” button to accept its terms and to continue with the installation. If you'd like to change the installation directory, or customize other features, place a check in the “Change destination folder”.

Figure 12

Click on the “Accept” button to accept the Java License Agreement and continue the Java installation.

• The “Java Setup – MSN Toolbar” window is displayed. By default the “Install the new MSN Toolbar” box is checked. If you do not want this installed, you will need to remove the check mark by clicking the box to remove the check mark. Then click on the “Next” button to continue the Java installation.

Figure 13

If you choose not to have the MSN Toolbar installed, click in the box to remove the check mark.

Then click the “Next” box to continue the Java installation.
• The “Java Setup - Progress” window will appear and Java will be installed.

**Figure 14**

![Java Setup - Progress](image)

- After the Java installation is completed you will see the “Java Setup – Complete” window that indicates that you have successfully installed Java. Click on the “Finish” button to complete and close the Java installation window.

**Figure 15**

![Java Setup - Complete](image)

• Once the installation is successfully completed, you may need to restart (close and re-open) your browser to enable the Java installation.
Installing the Remote Data Entry System Application

This section will walk you through installing the Remote Data Entry application. As previously mentioned you must have Java 1.5.0_02 or later installed on your system to run this application.

- You will click on the link provided on your Cooperative Group website for the Remote Data Entry application.

- You will click on the Remote Data Entry link. The “Java starting…” pop-up window will automatically appear.

Figure 16

- The first time that you access the Remote Data Entry application, the Warning – Security pop-up window may appear. If you place a check-mark in the box next to the statement “Always trust content from this publisher”, the message will not appear in the future.

- You will then click the “Run” button to continue installing and launching the application.

Figure 17

- Then the “Java Web Start” pop-up window will quickly flash on the screen as the application is downloaded onto your system. You may also see another pop-up window flash by briefly, indicating that the application is installing.
After the application has completed the installation, the “Forms System ...” window will be automatically opened and displayed.

Create a Desktop Shortcut to Remote Data Entry Application

- Right click with mouse on your desktop and select **New** and then select **Shortcut**
• Enter the following URL (http://ncctg.mayo.edu/webstart/jccs.jnlp) into the space provided and click on the **Next** button.

**Figure 21**

![Image of Create Shortcut window]

- Enter “Remote Data Entry Application” in box provided for the name of the shortcut and click on the **Finish** button.

**Figure 22**

![Image of Select a Title for the Program window]

- The shortcut is created and placed on your desktop.

**Figure 23**

![Image of remote data entry application shortcut]

Congratulations, you have now completed the installation process of the Remote Data Entry System and are ready to start using the application.
Start Using the Remote Data Entry Application

This section will demonstrate how to launch the application, login to the application and select study & subject, enter a new form, view a form, edit a form, save a form, and print a form.

Launch the Application

- Click on the Remote Data Entry application desktop shortcut to launch the application. If you do not have a desktop shortcut, go to the link provided on your Cooperative Group website for the Remote Data Entry application.

- The “Forms System …” window will be automatically opened and displayed.

Login to the Application and Select Study & Subject

All users are required to login into the application with a User Name and Password for authentication purposes. This establishes what study and subject data you are authorized to access. If you do not have a User Name and Password or you are unable to login successfully, please contact the Operations Office at (507) 284-5999.

- Click on the Study field and enter the data center protocol study number.

End of document.
• Study and Subject numbers are not case sensitive. If you enter them in lower case, the program will correct the case when they are located. The “Login” pop-up will appear. Enter your User Name and Password in the spaces provided, then click on the OK button to continue. The system will complete an authentication check in the background. If access is granted, the “Login” pop-up will close automatically and you will be redirected to the “Forms System …” window.

![Figure 26](image)
Enter your User Name and Password. If you do not have a User Name and Password or you are unable to login successfully, please contact the Operations Office at (507) 284-5999.

• Click on the Tab key and you will be taken to the Subject field, here you will enter the Subject ID number and press the Enter key. The protocol study schema will be displayed within the Application Window for the Study Name and Subject ID entered.

![Figure 27](image)

• If you do not know the Subject ID number, you can press the Enter key immediately following the entry of the data center protocol study number. The application will load and display a list of subjects that you are authorized to view.
Click on the desired subject and then click on the **OK** button to load the selected subject’s schema and forms.

**Enter a New Form**
This section will walk you through navigating within the Forms System Application Window, opening a new form, navigating within a form, saving a form, and printing the form.

**Navigation within the Application Window**
The Application Window is divided into three primary sub-windows; Trial Phase, Forms Available, and Cycle/Sequence Forms Entered.
Figure 29

1. Trial Phase Window
2. Forms Available Window
3. Cycle/Sequence Forms Entered Window
User, Study, and Subject Information – This title bar located at the top of the Forms System Window displays the User that is logged in, Study Number, Subject’s ID and the Subject’s Initials.

Figure 30

Trial Phase Window - The upper left-hand window contains the Trial Phases for the study.

- The folders ( ) displayed, are determined by the Study that is entered and portrays the schema defined by the study protocol.

Figure 31

- The arrows (>>) indicate that some data has already been collected for the subject at this phase of the study.

- If the study is not blinded, the user will see a letter within parenthesis (A). This letter defines which arm the patient has been placed on.

- Some of the more complicated studies may have additional help information available to assist the user in finding the correct phase for data entry. These messages will only appear if the additional help is available. The additional help information can be found in the Help Menu, under the Study Specific Help category.

- If no data has been entered for that phase of the study, the toggle ( ) will be in a horizontal position and the folder will be closed. If this is the case, you can open the folder by simply clicking on the key-like toggle switch ( ) and the folder will be opened.
NOTE: For some studies there may be additional screen shots of the application window available under the Help Menu – Study Specific Help.

**Figure 33**

*Forms Available Window* - The lower left-hand corner window contains a list of possible **forms available** for the phase of the study selected within the Trial Phase window.

*Cycle/Sequence Forms Entered Window* - The right-hand window displays the subject’s **cycles and sequences** entered for the form selected within the Forms Available window.

**Open a New Form**

This section will walk-thru the step-by-step process of opening a new form within the Forms System… window.

- Within the Forms System, you will navigate to the Trial Phase sub-window and click on the appropriate Trial Phase folder.

**Figure 34**

- Once you click on the appropriate Trial Phase folder the available forms will be automatically displayed within the Forms Available sub-window. Click on the appropriate form.
• If there were any previous cycles or sequences entered for the form selected; they will appear in the Cycles/Sequence Forms Entered sub-window.

Figure 36

Previous cycles and sequences will appear within this sub-window.

• If you are entering a form that represents a new cycle (visit), you will go to the lower right-hand side of the Entered Cycles/Sequences Forms sub-window. Enter the appropriate Cycle # (visit) in the box and then click on the Add Cycle (visit) button.

Figure 37

Enter appropriate Cycle # and then click on the Add Cycle button.

• You will select the Add Sequence button if you are entering multiple forms for the same cycle (visit).

Figure 38
• Note: Cycle and visit mean the same thing. Some phases do not allow cycles (visits), just sequences. Some Cooperative Groups may not use both sequences and cycles. Please see the Study Specific Help for the protocol you are completing data entry on, for further clarification of when to use the Add Cycle (visit) button.

• Once you click on the add button (no matter if it is a cycle or sequence) the form is automatically opened.

• When the form loads, the title bar at the top will contain the Study name, Patient ID, Cycle #, Sequence #, Patient Initials, and User name of person logged into system.

• You will be taken to the first field on the form.

• You may open more than one form at a time. You are allowed a maximum of 4 forms opened at the same time. If you exceed the max number of forms allowed to be opened, the message pop-up window will be displayed.
• Click the OK button to close the message pop-up window.

![Image of message pop-up window](image)

• At this point, if you want to continue to open a new form you have three options: 1) to complete and save one of the forms that you have opened (for Save as Complete instructions - refer to the Save Form section), 2) elect to save as Work in Progress-wip (for wip instructions - refer to the Save and Close Form section), or 3) choose to close one of the forms you currently have open without saving at all.

**Navigation and Data Entry within the Form**

This section will demonstrate how to navigate within the form and explain why it is very important to use the navigation rules provided. In addition it will walk you through the different types of data entry fields and the data entry options.

**Movement from Data Field to Data Field**

The Tab key must be used to move from data field to data field; to ensure that the programming rules and validation procedures are activated within the form. By using the mouse to navigate within the data entry screen the required data fields may be missed. Using the Tab key will ensure that the application correctly evaluates whether or not the answer you entered within the data field, should generate an Error message. Additionally, some data fields may be shown or hidden based on how you answer the questions, so using the Tab key will help ensure that this is done correctly.

**Field Types**

*Date* – you are not required to put any dashes or slashes in between the month, day, and year (e.g. 041808). You are only required to type in the last two digits of the year. After you have entered the date, the system will automatically reformat the date to the format of mm/dd/yyyy.
Dropdown Menu – with the mouse click on the downward arrow and then click on the appropriate answer.

Radio Button – radio button fields only allow you to select one answer. Click within the circle next to the appropriate answer.

Text Field – text fields are fields that do not allow you to choose between one or more answers (e.g. non-multiple-choice fields). When you tab to a text field that has existing data, it will be highlighted and you can simply type over and replace the existing text information. You can also use the arrow keys to change part or all of the answer in the text field.
Some text fields may display the number of expected digits required to be entered within the text field. An example of this would be a height measurement:

![Height measurement example](image)

A range is provided for the Height field, to ensure accurate data entry and flag potential data entry errors.

In addition, a range may be provided. The range consists of the acceptable upper and lower limits given for a data element field to ensure accurate data entry.

**Field Options**

**Comment Box** – the Comment Box may be used to: 1) provide additional information, 2) provide validation for a data element entered, or 3) indicate why you were unable to interpret the data the patient provided.

At any point in time, if you need to change the comment in the comment box, simply click on the Comment button to open the comment box and make the necessary changes.
How to Use the “Comment” Option

- Click on the **Comment** button

  ![Figure 49](image)

- The Enter Comment pop-up window will automatically appear.

  ![Figure 50](image)

  The only time that you will see the statement “Enter Required Comment” is when a comment is required; e.g. validate data entered within the data field.

- You are allowed to enter up to 200 characters. As you enter the comment, the number of characters remaining is shown below the text box provided.

  ![Figure 51](image)
• Click the **OK** button to save and close the Comment Box pop-up window. You will be automatically returned to the data entry form.

• Note that when a comment is entered, the Comment option changes color from grey to red.

Figure 52

![Image of Comment Box]

**OK** – this option is available as a radio button and is the default for all form fields.

**Not Done** – this option is available as a radio button. The **Not Done** button is used when a task or test has not been completed and **will not** be done. A comment is **not** required, but it is recommended to reduce the need for a query at a later date.

**How to Use the “Not Done” Option**

• Click on the **Not Done** radio button

Figure 53

![Image of Not Done Option]

**Validated** - this option is initially available as a radio button. This option is used when the field is flagged with an Error, to validate that the information entered is correct. Example: The patient’s height was entered as 215 cm and you have verified that the patient’s height is 215 cm. You are **required** to provide a comment to validate the out of range data entered and will not be allowed to move to the next field unless you change the data entered or complete the validation process by entering a comment.
How to Use the “Validated” Option

• Click on the **Validated** radio button.

**Figure 54**

- The “Message” pop-up window will automatically appear; click on the **Yes** button.

- The comment box will automatically appear. Enter the validation comment and click the **OK** button to save and close the comment box pop-up window.

- The pop-up window will close and you will be returned to the data entry form.

*Not Clear* - this option is available as a radio button. This option is only available on the Quality of Life (QOL) forms and will be grayed out on all other forms. This option should be used when a value is not marked per the instructions provided and requires interpretation to enter the information provided by the patient.

Example: A patient circled two numeric values when the instructions states to circle the value that best describes their USUAL level of fatigue during the past 24 hours. Click on the **Not Clear** radio button, click on **Yes** in the message box to continue and submit the comment ‘patient circled both 5 and 6:’

**Figure 55**
How to Use the “Not Clear” Option

- Select the Not Clear button.

**Figure 56**

- The message box will open to remind you that this button should only be used if you are unable to interpret the patient response and that a comment is required. Select Yes button.

**Figure 57**

- The comment box will open. Enter the explanation of why you were not able to interpret the data. Click the OK button. If you do not enter a comment and click OK, the “Not Clear” button will no longer be selected. **Note:** If a patient writes a comment in a booklet, enter patient comments exactly as they have been written, as this is critical for analysis. If any comment exceeds the 200 characters allowed, add the text “(additional comments in chart)” at the end of the comment in the comment field. Send a copy of the form with a cover page (see template at the end of this document) to the research base. See “Guidelines for Remote Data Entry of QOL Booklets” located in the Help Menu – Study Specific Help for further details regarding interpretable and not-interpretable data.
MedDRA Code Dictionary Lookup

The CTCAE V 3.0 has multiple versions of the MedDRA codes (e.g. v 6.0 – effective Oct. 1, 2003 and v 9.0 – effective July 1, 2006). It is advised that you use the built-in dictionary look-up utility to look-up the MedDRA codes.

- Type in all or part of the adverse event name and then click on the **Dictionary** button.

![Figure 58](image1.png)

- Select the correct MedDRA code for the event you are reporting and then click on the **Select** button.

![Figure 59](image2.png)

- The Dictionary look-up window will automatically close and you will be returned to the data entry form. The MedDRA Code will automatically be entered into the data field and the dictionary value explanation will be listed after the **Dictionary** button.
Note that you will need to enter the appropriate grade in the next data field provided – this is **not** automatically entered for you.

**Save & Close Form**

When exiting a form you have three options: 1) **Save as: Complete**, 2) **Save as: Work in Progress**, or 3) **Close Form** without saving.

**How to Close Form**

- If you choose to **Close Form**, the form will not be saved. To close the form you simply click on the **Close Form** button.

- The **Unsaved Changes** pop-up window will appear. Click the **Continue** button to close the window.

- The **Unsaved Changes** pop-up window and form will automatically close and you will be redirected back to the Cancer Center Forms System window.
How to Save As: Complete

- Click on the **Save as: Complete** button.

![Figure 64]

- The Save Form box will automatically appear.

![Figure 65]

- If no error(s) are found, the form will be saved, the data entry form will close automatically, and you will be redirected back to the Cancer Center Forms System window.

- If potential error(s) are found, the Message window will automatically appear indicating the number of error(s) found and you will be given the option to correct the potential error(s) before saving as complete.

- Click the **OK** button and you will automatically be redirected to the data entry form and taken to the first potential error found on the form.

![Figure 66]

- If you do not wish to correct the potential error(s) at this time, you may choose to **Save as: Work in Progress**.
How to Use the Work in Progress Feature

This feature allows you to save partially completed forms. Example: You have started a form and are called to see a patient; you could save the form as Work in Progress. This saves the form in a safe location and allows you to open the form and pickup where you left off at a later time point.

The Work in Progress feature is also a means of temporarily storing forms with potential error(s). Example: Save forms with errors that need additional investigation to resolve the error(s).

Forms placed in Work in Progress will not routinely be available to the statisticians for analysis and will not removed from your Outstanding Material Report.

- Click the **Save as: Work in Progress** button.
- The Save & Close Form box will automatically appear.

![Figure 67](image)

- The form will be **Save as: Work in Progress** (wip) and automatically closed. You will be redirected back to the Cancer Center Forms System window.

- Within the **Entered Cycle/Sequence Forms** window you will see the saved form with "wip" displayed at the end of the form name. You can return to the form at anytime to correct error(s) and **Save as: Complete**, by simply clicking on the form to open it.

![Figure 68](image)
View or Edit an Existing Form

You can view or edit an existing form at anytime.

- Within the Forms System, you will navigate to the Trial Phase sub-window and click on the appropriate Trial Phase folder.

![Figure 69](image)

- Once you click on the appropriate Trial Phase folder the available forms will be automatically displayed within the Forms Available sub-window. Click on the appropriate form.

![Figure 70](image)

- Select the form that you wish to view or edit from the Entered Cycles/Sequence Forms sub-window.

![Figure 71](image)
• When you have completed viewing the form, click the **Cancel** button to close the form.

• If you have made changes to the form, select the **Save as:** **Complete** to save the changes that you made.

**Print Form**

• Go to the **File Menu**, located on the top of the data entry form.

  ![Figure 72](image)

  **Figure 72**

  Go to the **File** menu and select **Print**.

  You may also use the keyboard shortcut by clicking on the **Ctrl & P** keys at the same time.

• The **Print** window will be automatically displayed.

  ![Figure 73](image)

  **Figure 73**

Congratulations – you have successfully completed navigating within the application, opening a new form, navigating within the form, saving the form, viewing and editing the form, and printing the form.
Understanding the Menu Operations

This section will go through the Menu Operations within the Forms Systems window and the Forms Data Entry window.

Menu Items within the Application Window

File Menu

Figure 74

- **Quit** – used to exit the data entry system.
- **Recover Memory** – this operation prompts the applications to try to recover memory, making your system run more quickly. Generally, this feature is not needed and you would only use these feature when prompted by the research base.

Options Menu

Figure 75

- **Font Size** – used to adjust font sizes. Fonts can be larger or smaller than the initially displayed.
• **Logger** – this feature is prompted by the research base and is used for troubleshooting. It sends information back to the programmers about the problems and errors you may be experiencing with the system.

• **Details** – if you wish to see all details within the **Forms Entered** window, select **Yes**. If you select this option, the name of the user and date completed will be displayed next to the completed forms within the **Forms Entered** window.

• **Close on Save** – when you choose to **Save as: Complete** or **Save as: Work in Progress**, the application will close the form automatically. If you want to be able to print the form before closing, change this setting to **No**.
• **Beep on** – if this option is selected, you will hear a beep when errors are detected within the form.

View Menu

• **Error Lists** – the error list you select will generate a report that will open in a separate pop-up window. You will only be allowed to view error lists that you have been granted permission to view.
- **Patient List** – this will provide a list of all patients that you have permission to access for the study protocol that you have selected.

- **Cycles/Sequences** – this option is used to update the database with the forms you have recently entered. You should only need to do this if you have created a lot of new sequences, but have not saved them.

- **Reload Forms** – selecting this option will cause the form to reload from the database. You may be asked to perform this action when trying to troubleshoot a problem with a data entry form.
- **About** - selecting this causes a pop-up window to appear, providing information on the Forms System version and patient information that may be requested by support persons if you are having problems with a form.

- **Menu Operations Help** - detail information on the main menu selections.

- **Study Specific Help** - if the study has a node labeled "Study Specific Help", then selecting this menu item will display any notes that have been added for this study. Typical information includes: Finding a correct node, and special data entry notes. Multiple screens may appear on this selection, if different areas require specific information.

- **Remote Data Entry Screen Instructions** - more general information on the content of the study structure and what to do at different steps in the study progression.

- **Cancer Control General Instructions** - general information geared to data entry for Cancer Control studies. *(Note: This section will not apply to ACOSOG studies.)*

- **Tips for Remote Data Entry** - an organized list of ongoing tips helpful in doing remote data entry.

- **Link to the Training Page** - a direct link to the Remote Data Entry training page. Available protocols and contacts can be accessed here.
• **Protocol** – a direct link to the study protocol page.

• **Registration Info** – a popup will display the registration information on a patient, such as Group, Member, Location, and Physician.

**Menu Items within the Forms Window**

**File Menu**

![Figure 87](image)

- **Save as complete** - Save the form (Ctrl-S).
- **Print** - Print the form (Ctrl-P).
- **Copy to your local file...** (Ctrl-A).
- **Close** – Close this form (Ctrl-C).

**Options Menu**

![Figure 88](image)

- **Font Size** - This option allows you to make the font displayed on the screen larger or smaller. The small font is selected by default.
View Menu

Figure 89

- **Next Form Error** - selecting this option will take your to the next Error on the form (Ctrl-E).

- **Next Query** – selecting this option takes your cursor to the next Query on the form (Ctrl-Y). The Query option has become obsolete, due to the “Work in Progress” capability. You may see this grayed out.

Help Menu

Figure 90

- **About** - provides versioning information, as well as some additional information that may be requested by the research base if you experience any difficulties with the system.